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About this manual

The OrCAD Layout Autorouter User’s Guide contains information about
autorouting in OrCAD Layout and OrCAD Layout Plus. Throughout this manual,
Layout is used to denote both Layout and Layout Plus. This manual only includes
information that is specific to autorouting. Information that is applicable to both
manual routing and autorouting is covered in the OrCAD Layout User’s Guide.

Before you begin

Before you can use Layout, you must install Microsoft Windows on your computer,
then install Layout. For information on installing Windows, see your Windows
documentation.

To install Layout, follow the installation instructions that accompany Layout.

Symbols and conventions

OrCAD printed documentation uses a few special symbols and conventions.

The keyboard

� The keys on your keyboard may not be labeled exactly as they are in this
manual. All key names are shown using small capital letters. For example, the
Control key is shown as CTRL; the Escape key is shown as ESC.

� Keys are frequently used in combinations or sequences. For example, SHIFT+F1
means to hold down the SHIFT key while pressing F1. ALT, F, A, means to press
and release each of these keys in order: first ALT, then F, then A.

� Arrow keys is the collective name for the UP ARROW, DOWN ARROW, LEFT

ARROW, and RIGHT ARROW keys.

� To choose a command from a menu, you can use the mouse or press a key
combination. For example: from the File menu, choose Open (ALT, F, O).
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Text

� Text you are instructed to type is shown in bold. For example, if the manual
instructs you to type *.max, you type an asterisk, a period, and the lowercase
letters max. The text you type is usually shown in lowercase letters, unless it
must be typed in uppercase letters to work properly.

� Placeholders for information that you supply (such as filenames) are shown in
italic. For example, if the manual instructs you to type cd directoryname, you
type the letters cd followed by a space and the name of a directory. For
example, for a directory named CIRCUITS, you would type cd circuits.

� Examples of syntax, netlist output, and source code are displayed in monospace
font. For example: /N0001 U1(8) U2(1);.
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Introduction to autorouting

Layout features two autorouting options: a gridded autorouter, and a gridless, shape-
based autorouter.

Gridded autorouter

Layout’s gridded autorouter has two key features: sweep technology, which allows
you to specify the directional emphasis for routing different boards, and shove
technology, which minimizes vias and allows extremely dense autorouting. In
addition, you can use interactive routing tools (see Interactive routing tools below)
with the gridded autorouter to refine the process of autorouting.

Sweep technology

The autorouter routes the board using sweeps, which are successive routing passes.
Beginning at a specified point, Layout routes the board continually according to the
sweep direction you specify. For example, if you want the sweeps to progress up
first and then to the left, the autorouter routes vertically and then horizontally,
working through the entire board.

& See    For information on setting sweep direction, see Editing route sweep
information in Chapter 3 of this manual.

Shove technology

The autorouter finds the optimal space for a given track and then moves or “shoves”
other tracks out of the way before routing in that area. If a pad or via is blocking the
routing path, then the autorouter attempts to go around the blockage by routing to a
different layer using a via. The autorouter also checks to see if there are obstructing
tracks that can be rerouted or moved to an entirely different location on the board.

Chapter 1
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Interactive routing tools

Though not part of the autorouter itself, interactive routing tools complement the
gridded autorouter by allowing you to refine an autorouted board. Using auto path
route mode and shove track mode, you can route critical nets and dense boards with
minimal effort.

& See    For information on auto path route mode and shove track mode, see Using
interactive routing tools in chapter 2 of this manual.

Gridless shape-based autorouter

Layout Plus provides a gridless shape-based autorouter called SmartRoute.
Exclusive to Layout Plus, SmartRoute has fast routing speeds, high completion rates,
and high router quality.

& See    For information on SmartRoute, see the OrCAD Layout SmartRoute User’s
Guide.
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Using autorouting and interactive
routing

This chapter explains how to prepare a board for autorouting, how to route a board
using autorouting, and how to optimize autorouting results using interactive routing
tools.

& See    This chapter describes processes and modes relevant to autorouting and
interactive routing tools. Layout commands and modes for manual routing are
covered in Chapter 8: Routing the board in the OrCAD Layout User’s Guide.

You probably performed the following tasks when you set up the board and placed
components. If not, you need to do so to prepare the board for routing.

� Designate appropriate layers as plane layers or routing layers

� Define vias

� Set or verify net properties

� Run Placement Spacing Violations and correct any spacing violations

& See    For information on designating plane layers, defining vias, and setting net
properties, see Chapter 4: Setting up the board in the OrCAD Layout User’s
Guide. For information on running Placement Spacing Violations, see Chapter 7:
Placing and editing components in the OrCAD Layout User’s Guide.

Chapter 2
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After you have completed the above items, you are ready to begin the routing
process. The steps in the autorouting process are:

� Check the board outline, via definitions, and routing and via grids

& See    For information on checking the board outline, via definitions, and routing
and via grids, see Checking the board outline, via definitions, and routing and via
grids in Chapter 8: Routing the board in the OrCAD Layout User’s Guide.

� Load a routing strategy file

� On predominantly through-hole boards, verify connections to the planes

� On SMT boards, implement fanout for power and ground

� Pre-route critical nets

� Implement autorouting

� Optimize routing using the interactive routing tools

� Check for route spacing violations and check routing statistics

& See    For information on checking for route spacing violations and checking
routing statistics, see Checking routing in Chapter 8: Routing the board in the
OrCAD Layout User’s Guide.

� Optimize routing using Layout’s routing commands

& See    For information on optimizing routing with Layout’s routing commands,
see Optimizing routing using Layout’s routing commands in Chapter 8: Routing
the board in the OrCAD Layout User’s Guide.
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Loading a routing strategy file

A routing strategy file determines which default routing layers to use, when to use
vias, which direction the track should travel, which colors to use for routes, and the
size of the active routing window. There are many routing strategy files provided
with Layout, among which are files for two-layer, four-layer, six-layer, and eight-
layer boards. Load the routing strategy file that is most suitable for your board.

& See    For a complete list of the routing strategy files provided with Layout, see
Strategy files in Appendix A: Understanding the files used with Layout in the
OrCAD Layout User’s Guide.

To load a routing strategy file

1 From the File menu, choose Load. The Load File dialog box displays.

2 If necessary, change Files of type to Strategy.

3 Select a routing strategy file (.SF), then choose the OK button.

6 Tip    Layout provides two types of strategy files: placement strategy files and
routing strategy files. Although both types of files have a .SF extension, placement
strategy files begin with the letters “PL.”
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Routing power and ground on predominantly through-hole boards

If you are working with a through-hole board, you must verify that all power and
ground nets are connected to the proper plane layers before autorouting. If they are
not, you must complete these connections (for example, an edge finger needs to be
routed to a via for connection to the plane).

On through-hole boards, the appropriate nets are automatically attached to the plane
layers with thermal reliefs. If the power or ground nets did not connect to the plane
layers, one of three errors may have occurred in the netlist:

� The global power pin is not defined in the part.

� The pin is not connected to the proper signal.

� If the pin is connected, it does not have the correct signal name.

To remedy the problem, either modify the schematic and annotate it again, or modify
the board by adding a pin to the signal. Keep in mind that this board modification
cannot be back annotated to the schematic.

& See    For information on adding pins to nets, see Adding and deleting pins
connected to nets in Chapter 8: Routing the board in the OrCAD Layout User’s
Guide.

Layout automatically recognizes nets that have been properly connected to plane
layers by making these nets invisible. You may also use the Nets spreadsheet to
verify connections to plane layers prior to post processing.

If the board has a split plane, you can verify that the power and ground nets are
properly connected to the appropriate plane areas by viewing the plane layers. If
power and ground display as thermal reliefs, then they are indeed connected.

& See    For information about split planes, see Creating split planes in Chapter 8:
Routing the board in the OrCAD Layout User’s Guide.

You can also view the thermal connections using the post process preview. For
information about viewing thermal reliefs, see Previewing thermal reliefs in
Chapter 9: Using thermal reliefs and copper pour zones in the OrCAD Layout
User’s Guide.
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Connections to the planes can be verified prior to post processing by verifying that
only nets connected to the planes are enabled, then viewing the Statistics spreadsheet
to verify that these nets are 100% routed.

To verify connections to the planes

1 Choose the spreadsheet toolbar button, then choose Statistics. The Statistics
spreadsheet displays.

2 If necessary, respond to the message asking if you want to repour copper by
choosing the Yes button.

3 Scroll until you find the Routed row, which is the beginning of the routing data.
You should see a value of 100% in the Enabled column for % Routed, which
indicates that the appropriate nets are connected to the plane layers.

4 If the value is anything less than 100%, choose the refresh all toolbar button.

5 If the value is still anything less than 100%, minimize the Statistics spreadsheet,
choose a routing tool, and route the net to the appropriate plane layer.

6 Maximize the Statistics spreadsheet, then choose the refresh all toolbar button.

7 After you’ve verified that the value in the Enable column for % Routed is
100%, close the Statistics spreadsheet.
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Fanout on boards with surface mount devices

Before routing a board with surface mount devices (SMDs), you must perform
fanout to connect the power and ground nets to the plane, then run Design Rule
Check (DRC) to verify that fanout is complete.

Fanout is a method for facilitating route operations for surface mount pads on a
board. It is the process of routing an SMD pin to a via so that the connection to the
component can be routed on other layers. For power and ground pads, the target via
is attached to a power or ground plane using a thermal relief.

Fanout is especially useful for:

� Multilayer boards that include power and ground planes

� Densely packed boards that do not permit routing on surface layers

� Boards that include fine-pitch components that impede surface routing

Fanout is commonly used to route the power and ground layers of an SMT board.
However, you can also perform full board fanout, which is sometimes helpful for
routing dense, multilayer SMT designs.

Layout has three fanout commands: Board, DRC/Route Box, and Component.

� Board implements fanout for the entire board.

� DRC/Route Box implements fanout for all SMD components within the
DRC/Route Box (represented on screen by a rectangle with a dashed border).

� Component implements fanout for a selected SMD component.

Each command performs fanout on a different scale: at the board level, a user-
specified area (the DRC/Route Box) and the component level. You can modify
options for all three within the Fanout Settings dialog box (available by choosing
Fanout Settings from the Options menu).
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Implementing power and ground fanout

Power and ground fanout must occur before any signal routing. Power and ground
fanout connects all surface mount power and ground pins to the appropriate plane
layer. This is done by means of a via that extends to the thermal relief connection.

Before you implement power and ground fanout, you must assign the power and
ground nets to plane layers so that the router will recognize these nets as voltage nets
rather than signal nets.

& See    For instructions on assigning nets to plane layers, see Enabling layers for
routing in Chapter 4: Setting up the board in the OrCAD Layout User’s Guide.

To fanout power and ground

1 From the Options menu, choose Fanout Settings. The Fanout Settings dialog
box displays.

2 Select the Fanout Power/Gnd option and your choice of the options under it.
(See the description of the options in this chapter.)

3 Deselect the Fanout Signals option.

4 If you want fanout to place vias inside (or under) SMDs, select the Inside
option.

5 If you want fanout to place vias outside SMDs, select the Outside option.

6 In the Maximum Fanout Distance text box, specify the maximum distance from
the SMD pad to the fanout via, then choose the OK button.

7 From the Auto menu, choose Fanout, then choose Board.

8 From the Auto menu, choose Design Rule Check. Select the SMD Fanout
Violations option in the Check Design Rules dialog box, then choose the OK
button.

9 If necessary, use the interactive routing modes to route all fanout failures (such
as No Connection to Plane), using the error markers as a guide.

& See    For instructions on using the interactive routing tools, see Using interactive
routing tools in this chapter.

10 Repeat steps 7 through 9 until all power and ground pins are properly fanned
out.
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The Fanout Settings dialog box

Fanout Power/Gnd    Determines whether Layout implements fanout for power
and ground SMD pads. Power and ground pads are identified by being enabled on an
appropriate plane layer, as shown in the Nets spreadsheet.

Lock after fanout. Locks the fanout tracks and vias for power and ground nets after
fanout is complete. This prevents the autorouter from moving the fanout vias away
from their respective pads.

Disable after fanout. Prevents power and ground nets from being routed after fanout
is complete. This is especially advantageous if you plan to perform autorouting
immediately after fanout is complete. If fanout fails to complete all pads for the
power and ground nets that are enabled, a message displays to that effect.

Share close vias. Permits tracks belonging to the same power or ground net to share
a single via. Use discretion before selecting this option: via sharing can result in long
fanout tracks or large currents.

Use free vias. Permits the use of free vias for optimal implementation of power and
ground fanout. If this option is not selected, regular vias are used.
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Fanout Signals    Determines whether Layout implements fanout for signals
connected to SMD pads. A signal is any net that is not enabled on a plane layer.

Lock after fanout. Locks the signal tracks and vias after fanout is complete. In
general, it is best to leave signal tracks unlocked, so the autorouter can move them as
necessary to finish routing the board.

Share close vias. Permits tracks belonging to the same signal to share a single via.
Via sharing for signals reduces the number of vias on (and, therefore, the congestion
of) the board.

Use free vias. Permits the use of free vias for optimal fanout of signals connected to
SMD pads. If this option is not selected, regular vias are used.

Inside    Allows Layout to place fanout vias inside (or under) the SMD.

Outside    Allows Layout to place fanout vias outside the SMD.

Maximum Fanout Distance    The value you set for this option determines the
maximum distance from an SMD pad to a fanout via. This distance is the Euclidean
distance (measured from the center of the SMD pad), not the cumulative distance of
the associated track segments. By default, the value for this option is 300 (mils).

O Note    Layout places vias on grid points only. If there is no grid point within the
maximum distance you specified, a via may be placed on a grid point beyond this
distance.
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Implementing full board fanout

It is not necessary to implement fanout for all pads that are not connected to power
and ground, because the router can route pads for which it could not place a fanout
via.

For multilayer SMD boards, you should normally let the router determine via
locations, rather than implement fanout. The sheer number of vias created with
fanout can block too many channels for the router to work efficiently, especially on
dense SMD boards.

However, for fine pitch components, it is useful to run component fanout, since this
is typically the only way you can fanout all pins without blocking off one or more
pins in the process.

Before you implement full-board fanout, ensure that power and ground are disabled
for routing and that all other signals are enabled.

& See    For instructions on enabling signals for routing, see Disabling power and
ground in this chapter.

To complete full board fanout

1 From the Options menu, choose Fanout Settings. The Fanout Settings dialog
box displays.

2 Deselect the Fanout Power/Gnd option.

3 Select the Fanout Signals option and your choice of the options under it. (See
the description of the options in this chapter.)

4 If you want fanout to place vias inside (or under) SMDs, select the Inside
option.

5 If you want fanout to place vias outside SMDs, select the Outside option.

6 In the Maximum Fanout Distance text box, specify the maximum distance from
the SMD pad to the fanout via, then choose the OK button.

7 From the Auto menu, choose Fanout, then choose Board.
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Using interactive routing tools

Online DRC (design rule check) is automatically activated whenever you choose
either of the interactive routing tools (shove track or auto path route). In addition,
you can only use the interactive routing tools on connections within the DRC box.

& See    For information on the DRC box, see Defining a DRC box in Chapter 8:
Routing the board in the OrCAD Layout User’s Guide.

Shove track mode is considered interactive routing because you are interacting with
the automatic push-and-shove routing capabilities of Layout when you are routing a
track.

Auto path route mode (not available in Layout Engineer’s Edition) is considered
interactive routing because you are interacting with the autorouter when it suggests
tracks and suggests via placement (if you select the Suggest Vias option in the Route
Settings dialog box).

Using shove track mode

When you use shove track mode, Layout shoves other tracks out of the way of the
track that you are currently routing. With this mode, you can pick up individual
connections and route them aided by the shove capability, manually route critical
tracks, and edit tracks and vertices.

To set routing parameters for shove track mode

1 From the Options menu, choose Route Settings. The Route Settings dialog box
displays.

2 Select the Shove Track Mode option, select one of the following options, then
choose the OK button.

Low Power    The router moves tracks only slightly, or conservatively, in an
attempt to move them out of the way as you add new tracks.

Medium Power    The router shoves tracks, and may even push routes over
other items (such as pads) and around other tracks in an attempt to move them
out of the way as you add new tracks.

High Power    The router rips up, shoves, and reroutes existing tracks as you
add new tracks.
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To use shove track mode

1 Choose the shove track toolbar button.

2 Define the DRC box size to encompass your area of interest.

3 Select a connection with the left mouse button. The connection attaches to the
pointer.

4 Drag the pointer to draw a track on the board.

5 Click the left mouse button or press the SPACEBAR to create vertices (corners) in
the track.

6 When drawing the last segment for the connection, choose Finish from the pop-
up menu. The track automatically connects to the center of the pad. A complete
connection is indicated by the cursor changing size and the ratsnest disappearing
from the pointer.

6 Tip    When you use shove track mode, the router does not automatically show
you where vias are needed. To change layers while routing a track, press the key
corresponding to the target layer (for example, to change to the bottom layer, press
2). The router clears away tracks around the via you are inserting when you click
the left mouse button to accept the first segment on the new layer.

6 Tip    While routing, if you press the ALT key and click the left mouse button on a
track, you can begin a new track on another track of the same net, which is known
as T-routing.

Using auto path route mode

When you use auto path route mode (not available in Layout Engineer’s Edition),
Layout suggests a possible track when you select a ratsnest or pin. As you move the
cursor, the suggested track changes position. When you click the left mouse button,
auto path route mode places the suggested track using the push-and-shove routing
capabilities of the autorouter, thereby clearing away any imposing tracks. Note that
the final track may not look like the suggested track. You can only use auto path
route mode with online DRC enabled. Attempting to disable online DRC takes you
out of auto path route mode.

6 Tip    If you double-click on a connection, auto path route mode routes the track
for you automatically.

When you use auto path route mode with the Suggest Vias option selected in the
Route Settings dialog box (from the Options menu, choose Route Settings), Layout
displays potential via locations as you’re routing, and removes them if they’re not
needed in the final version of the track.
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To set interactive autorouting options for auto path route mode

1 From the Options menu, choose Route Settings. The Route Settings dialog box
displays.

2 Select the Auto Path Route Mode option, select one of the following options,
then choose the OK button.

Allow Off-Grid Routing    This option allows auto path route mode to display
possible routing paths without regard to the routing grid. Selecting this option is
the only way to permit auto path route mode to end tracks at an obscure angle of
approach. Off-grid routing is almost always needed for mixed-pitch boards.

Shove Components    This option allows auto path route mode to shove
components in much the same way as it shoves tracks. That is, when you place a
vertex using the left mouse button or SPACEBAR, any imposing components are
moved away from the vertex (unless those components are locked).

Maximize 135 Corners    This option allows auto path route mode to
optimize routing space with vertices of 135° or 90°. If deselected, the autorouter
creates 90° corners only.

Pre-routing critical nets

Before autorouting, you should route critical nets manually and lock them to the
board.

To route a critical net

¬ Choose an interactive routing tool and route a critical net by following the
instructions given in To use shove track mode earlier in this chapter.

To lock a critical net

1 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet
displays.

2 Select the appropriate row using CTRL and the left mouse button.

3 From the pop-up menu, choose Lock.
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Autorouting a board

Once you’ve routed the power and ground nets, you should disable them for routing,
and enable the other nets on the board for routing.

Disabling power and ground

To disable the power and ground nets and enable other nets

1 Choose the spreadsheet toolbar button, then choose Nets.

2 Click once in the title cell of the Routing Enabled column. The entire column is
highlighted.

3 From the pop-up menu, choose Enable<->Disable. The Routing Enabled for the
VCC and GND nets changes to No*, and the Routing Enabled changes to Yes
for the rest of the nets.

Running the autorouter

The autorouter initiates a series of routing passes that systematically route an entire
board.

6 Tip    Before you begin routing the board, save your board file.

The routing strategy file you loaded determines which passes are performed on your
board during autorouting. You can see which passes are enabled and alter the
number of passes performed using the Route Pass spreadsheet.

& See    Each pass is described and the process for enabling passes is explained in
Editing route pass parameters in chapter 3 of this manual.

The autorouter begins its initial pass inside the DRC box. By default, the DRC box is
located on the densest area of a board. You may choose, however, to customize and
specify the size and location of the DRC box.

& See    For information on defining and moving a DRC box, see Defining a DRC
box in Chapter 8: Routing the board in the OrCAD Layout User’s Guide.

To run the autorouter

1 From the Auto menu, choose Autoroute, then choose Board. The autorouter
runs the passes specified by the routing strategy file you loaded.

2 Either run additional passes on the board, or optimize the board using Layout’s
interactive routing tools.
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Generating test points automatically

Before you can have Layout generate test points automatically, you must specify
which vias and nets you want to use for this purpose. Having done this, you can run
the test point routine, which adds test points to vertices (corners) on relevant nets.
After Layout completes this process, you can check the board for test point
violations and create an index of test points in a test points text file (*.TXT).

M Caution    Do not use Via 1 as a test point. It is used as the default by the router.

To generate test points automatically

1 Choose the spreadsheet toolbar button, then choose Padstacks. The Padstacks
spreadsheet displays.

2 Select a cell in the Padstack or Layer Name column that contains the name of a
via that shows all layers as Undefined. All of the cells pertaining to that
particular via are highlighted in black.

3 From the pop-up menu, choose Properties. The Edit Padstack dialog box
displays.

4 Enter values for Pad Width and Pad Height, select the Use For Test Point
option, then choose the OK button. Close the Padstacks spreadsheet

5 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet
displays.

6 Using the left mouse button and the CTRL key, select nets that need test points.

7 From the pop-up menu, choose Properties. The Edit Net dialog box displays.

8 Select the Test Point option, then choose the OK button. Close the Nets
spreadsheet.

9 Route the board to completion.

10 From the Options menu, choose Test Point Settings. The Test Point Settings
dialog box displays.

11 Select the options of your choice (see the description of the options in this
chapter), then choose the OK button. Layout places test points on each of the
nets you specified.

12 From the Auto menu, choose Design Rule Check. The Check Design Rules
dialog box displays.

13 Choose the Clear All button, then select Test Point Violations and choose the
OK button. Layout notifies you of any errors that were found.

14 Correct any test point violations.
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15 From the Auto menu, choose Create Reports. The Generate Reports dialog box
displays.

16 Select the Test Points option, select the Save As File option, then choose the OK
button. The TPOINT.TXT file is created.

17 From the File menu, choose Text Editor. A Notepad window displays.

18 From the Notepad window’s File menu, choose Open.

19 Locate and select the TPOINT.TXT file, then choose the Open button.

Test Point Settings dialog box

Generate test points from vias    When selected, this option creates test points
from vias that are defined in the Padstacks spreadsheet.

Allow test points under components    When selected, this option allows
Layout to position newly created test points under board components. If you do not
select this option, Layout can only place test points outside of component outlines.

Allow through-hole as test points    When selected, this option allows Layout
to use through-hole pins as test points.

Test Point Pitch    The value you specify for this option determines the minimum
spacing allowed between test points.
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Routing single-sided boards

When routing a single-sided board, start with a netlist and a technology template
optimized for single-sided boards. Layout provides three such technology templates:
JUMP5535.TCH, JUMP6035.TCH, and JUMP6238.TCH. After you create a new
board, you must create a board outline (technology templates do not contain board
outlines), place the board, and load a strategy file that allows for jumper wires. Two
strategy files for jumper wires are provided with Layout. They are JUMPER_H.SF
(for horizontal jumpers) and JUMPER_V.SF (for vertical jumpers). You can also
create a single-sided board using an existing board file. This section describes both
processes.

To route a single-sided board starting from a netlist

1 Choose the library manager toolbar button. The library manager displays.

M Caution    Do not permanently alter or modify any standard footprints. Use the
Save As command in the library manager to create new footprints.

2 Create route keepouts for all of the footprints that will be placed on the jumper
layer (this keeps the jumper vias outside of the components) by selecting a
library and a part in the library manager. The relevant footprint displays in the
footprint editor.

3 Select the place outline of the footprint by clicking on it with the left mouse
button. Choose Copy from the pop-up menu, then choose Properties from the
pop-up menu. The Edit Obstacle dialog box displays.

& See    For information on editing and copying obstacles, see Editing obstacles and
Copying obstacles in Chapter 5: Creating and editing obstacles in the OrCAD
Layout User’s Guide. For information on the library manager, see Chapter 14:
Creating and editing footprints in the OrCAD Layout User’s Guide.

4 Select an Obstacle Type from the drop-down list, then choose the OK button.

5 Place the route keepout on the jumper layer.

6 When opening a new board, select one of the following technology templates in
the Load File dialog box: JUMP5535.TCH, JUMP6035.TCH, or
JUMP6238.TCH.

& See    For instructions on opening a new board, see Chapter 2: Getting started in
the OrCAD Layout User’s Guide.

& See    For descriptions of JUMP5535.TCH, JUMP6035.TCH, and
JUMP6238.TCH, see Appendix A: Understanding the files used with Layout in the
OrCAD Layout User’s Guide.
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7 Create a board outline, and set up other desired board criteria using the
instructions in Chapter 4: Setting up the board in the OrCAD Layout User’s
Guide.

8 Open the Layers spreadsheet and double-click on the jumper layer. The Edit
Layer dialog box displays.

9 Choose the Jumper Attributes button. The Jumper Lengths dialog box displays.

10 Enter the appropriate values, then choose the OK button.

11 Select preplaced components by pressing CTRL and clicking the left mouse
button. Press L to lock the components in position.

12 Place the rest of the board.

13 From the File menu, choose Load. The Load File dialog box displays.

14 Select one of the two jumper strategy files: JUMPER_H.SF (for horizontal
jumpers) or JUMPER_V.SF (for vertical jumpers). You should choose the
strategy that corresponds to the longer axis of your board (horizontal or
vertical). Choose the Open button.

15 Adjust the DRC box to encompass the entire board. If this is not possible, make
the DRC box as large as possible.

& See    For information on the DRC box, see Defining a DRC box in Chapter 8:
Routing the board in the OrCAD Layout User’s Guide.

16 Route the board.

17 From the Options menu, choose Jumper Settings. The Jumper Lengths dialog
box displays.

18 Enter the appropriate data, then choose the OK button.

19 From the Tool menu, choose Jumper, then choose Convert to Components. All
of the jumpers created during routing are automatically converted into jumper
components, and display both in the parts list and on the silkscreen layer.
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To route a single-sided board starting with an existing board file

1 Choose the spreadsheet toolbar button, then choose Layers. The Layers
spreadsheet displays.

2 Double-click on the row of the layer that you want to designate as a jumper
layer. The Edit Layer dialog box displays.

3 Select the Jumper Layer option, then choose the OK button. The router
automatically creates a jumper on that layer, if needed.

4 In the Layers spreadsheet, double-click once again on the layer that is now
designated as the jumper layer. The Edit Layer dialog box displays.

5 Choose the Jumper Attributes button. The Jumper Lengths dialog box displays.

6 Enter the appropriate data, then choose the OK button.

7 Secure components that must stay in their current position on the board by
selecting them and choosing Lock from the pop-up menu. This locks the
components on the board.

8 Create route keepouts for all of the components on the jumper layer (to keep the
jumper vias outside of the components). The easiest way to do this is to make a
copy of the place outline and define the copy as a route keepout using the Edit
Obstacle dialog box. Then, place the route keepout on the jumper layer.

& See    For information on editing and copying obstacles, see Editing obstacles and
Copying obstacles in Chapter 5: Creating and editing obstacles in the OrCAD
Layout User’s Guide. For information on the footprint editor, see Chapter 14:
Creating and editing footprints in the OrCAD Layout User’s Guide.

9 From the File menu, choose Load. The Load File dialog box displays.

10 Select one of the two jumper strategies: JUMPER_H.SF (for horizontal
jumpers) or JUMPER_V.SF (for vertical jumpers). You should choose the
strategy that corresponds to the longer axis of your board (horizontal or
vertical). Choose the Open button.

11 Adjust the DRC box to encompass the entire board. If this is not possible, make
the DRC box as large as possible.

12 Route the board.

13 From the Options menu, choose Jumper Settings. The Jumper Lengths dialog
box displays.

14 Enter the appropriate data, then choose the OK button.

15 From the Tool menu, choose Jumper, then choose Convert to Components. All
of the jumpers created during routing are automatically converted into jumper
components, and display both in the parts list and on the silkscreen layer.
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Creating jumpers for single-sided boards

Using the Convert to Components command, you can replace “fake” jumpers with
jumper components selected from the footprint library.

To create jumpers for single-sided boards

1 Choose the spreadsheet toolbar button, then choose Layers. The Layers
spreadsheet displays.

2 Double-click in the row of the layer that you want to designate as a jumper
layer. The Edit Layer dialog box displays.

3 Select the Jumper Layer option, then choose the Jumper Attributes button. The
Jumper Lengths dialog box displays.

4 Set options to specify the jumper lengths, footprints, direction and designator,
then choose the OK button twice to close the dialog boxes. Close the Layers
spreadsheet.

5 From the Tool menu, choose Jumper, then choose Convert to Components. This
converts the routed via patterns into the actual components you have selected
from your library.

Error markers are created wherever Layout is unable to find a suitable jumper
component for a via pattern that exists on the board, or if component-to-component
violations are created in the process of inserting the jumpers.

Layout replaces the padstacks originally assigned to the jumpers with the padstacks
assigned to the vias that were used during routing, as long as you use the default
jumper padstack name J1.

If you do not want the router to route jumpers under components, include a keepout
area on the jumper layer in the footprints that you create for the single-layer boards
by duplicating the existing place outline onto the jumper layer and converting the
copy into a route keepout.
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Using routing strategy files

Routing strategy files determine which default routing layers to use, when to use
vias, in which direction the track should travel, and the size of the active routing
window. They also set up the appropriate graphical display for routing. This chapter
lists and describes the routing strategies included with Layout, and explains how to
edit routing strategy files.

The parameters for the strategy files provided with Layout are set according to the
type of board (component type and number of layers) for which the strategy file is
intended. In most circumstances, these parameters do not need to be changed.
Changing the parameters can negatively affect routing results.

& See    For a complete list of the routing strategy files used with Layout, see
Appendix A: Understanding the files used with Layout in the OrCAD Layout
User’s Guide. For information on loading routing strategy files, see Loading a
strategy file in Chapter 2: Using autorouting and interactive routing in this
manual.

Chapter 3
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Editing strategy files

The strategy files are based on information in four sets of data: sweep parameters,
pass parameters, layer parameters, and spacing parameters. You can view these four
data sets in spreadsheet form by using the spreadsheet toolbar button. By editing the
parameters in these spreadsheets, you can create new strategy files (.SF) and edit the
existing strategy files that drive autorouting. The spreadsheets are listed below.

Route Sweep    Using the Route Sweep spreadsheet, you can edit the existing
route sweep parameters.

Route Pass    During autorouting, the router makes a specified number of cycles or
sweeps through the current working area (component, DRC Box, or board). During
the sweeps, the autorouter uses different routing mechanisms in the attempt to route
the connections. Using the Route Pass spreadsheet, you can enable and disable
sweeps and sweep passes.

Route Layer    This spreadsheet contains information such as the primary direction
in which tracks should travel on a given layer (horizontal or vertical), between pins
cost, and layer cost. Using the Route Layer spreadsheet, you can edit the route layer
parameters set for the board.

Route Spacing    This spreadsheet shows the amount of space the router allocates
among various board elements. This data is used to assign a specific value to spacing
between tracks, vias, and pads (and any combination thereof). These values can also
vary by layer.
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Editing route sweep parameters

A sweep is the automatic movement of an active routing window over the entire
board area. You set general routing criteria, such as the size of the DRC box and the
sweep direction, by editing the data in the Route Sweep spreadsheet. The autorouter
uses the criteria from Sweeps 1 through 6, but not from Sweep 0. Sweep 0
influences the behavior of the interactive routing tools: shove track and auto path
route.

The differences among the sweeps are explained below.

Sweep 0 (Win/Comp)    This sweep sets the criteria for a single window or a
component within a window; it affects the behavior of the interactive routing tools,
shove track and auto path route.

Sweep 1 (Preliminary Route    This sweep most effectively routes memory
components and tracks that can be routed using simple patterns.

Sweep 2 (Maze Route)    During maze route, the router routes connections by
attempting different paths. This sweep routes the bulk of the tracks on a typical
design, using the full shove and retry capabilities of the router. The router finishes
each routing window to as close to 100% as possible, then moves to the next
window.

Sweeps 3, 4, and 5 (Next 1, Next 2, and Next 3)    The Next sweeps should be
used after the autorouter has completed a full sweep through the board, preferably
when the board has been routed to 93% or better.

6 Tip    Another good strategy to use after Maze 1 and Maze 2, is to set a smaller
routing grid (if legal) and run Maze route again. Reduce the grid by a factor of one
to three. For example, if your routing grid is set to 25, you could try running Maze
route using a grid of 81/3.

The first Next sweep cycles through the remaining connections on the design
quickly, completing the board if possible, but leaving any extremely difficult
connections for later sweeps. The second and third Next sweeps attempt each
remaining connection up to 100 times, in order to route the board to completion.

Unlike a sweep that has a primary and secondary direction, a Next sweep uses the
Route Next Connection setting as its guide. As a result, the router does not follow a
set pattern through the board, but instead searches for unrouted connections,
centering the routing window on each one in turn.

If you run the Next sweeps and there are still connections left to route, you can run
another Next sweep using one of the other two passes.

Sweep 6 (Special Options)    This sweep has three distinct purposes: to run a
fast route to determine routing ability, to reduce the number of vias on a board, and
to smooth and straighten corners.
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To edit route sweep information

1 Choose the spreadsheet toolbar button, choose Strategy, then choose Route
Sweep. The Route Sweep spreadsheet displays.

2 Double-click in a cell in the Route Sweep spreadsheet. The Sweep Edit dialog
box displays.

3 Edit the options as desired, then choose the OK button

The Sweep Edit dialog box

Diagonal Routing    Enable or disable diagonal routing. If you select the
Maximize option, Layout uses a 45° angle to route a connection whenever possible
(except if a 90° angle is necessary to clear pads and obstacles during routing).
Maximize is the default, because routing at 45° angles is recommended, to minimize
the number of segments on the board.

Sweep Direction    When performing sweeps, the router divides the board into
equally-sized rows and columns. The number of rows and columns depends on the
size of the route box (DRC box). During routing, the router travels up and down and
across the board using these columns in the direction you specify. For example, if
you select the Up, Left option, the router travels up and down the columns from the
defined DRC box, working first from the right to the left side of the board. That is, it
finishes routing each column before moving to the next column to the left. Each time
the router reaches the edge of the board, it returns to the defined DRC box before
continuing.
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Route Box    You can change the size of the DRC box using this option. Changing
the size of the DRC box is usually the only adjustment you have to make in the
Sweep Edit dialog box. The default route box size is 250 x 200.

O Note    The DRC/Route Box sizes are in grid units. For instance, with a 25 mils
grid, there are 40 grids per inch, meaning that a 250 x 200 window would actually
be 6.25 x 5 inches.

The following values are recommendations:

20 mils or 25 mils grid 5 mils, 81/3 mils, or 10 mils
grid

Default 250 x 200 250 x 200

Maximum 300 x 250 350 x 300

& See    For information on the DRC box, see Defining a DRC box in Chapter 8:
Routing the board in the OrCAD Layout User’s Guide.

Overlap X, Y    The Overlap percent determines the amount of space the router uses
to reroute tracks as it moves from window to window. It is recommended that you
leave these values at the default. If the overlap is too small, you could end up with
many small partial routes. If the overlap is too big, the router will tend to try to rip
up unneeded routes.
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Editing route pass parameters

You can enable and disable sweeps and sweep passes using the Route Pass
spreadsheet. You can also access and modify some of the routing parameters set in
your strategy file, such as via cost, retry cost, route limit, and attempts.

O Note    There is usually no benefit in running multiple passes per sweep. The
three passes per sweep listed in the Route Pass spreadsheet are there as
alternatives and are intended to be run one pass per sweep.

To edit route pass information

1 Choose the spreadsheet toolbar button, choose Strategy, then choose Route
Pass. The Route Pass spreadsheet displays.

2 Double-click in a cell in the Route Pass spreadsheet. The Edit Route Pass dialog
box displays.

3 Select the Enabled option to enable the pass for autorouting.

The Edit Route Pass dialog box

Enabled    Select the Enabled option to enable or re-enable the pass.

Done    The Done checkbox is selected after the autorouter has completed the pass
you’re editing.
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Type    Select the type of pass that you want the autorouter to perform.

Heuristics. Sweeps through the design in an attempt to route connections using
simple wire patterns defined by the router.

Fanout. Routes most SMT pads to through vias. The router uses a simple pattern
search to locate legal locations inside, and then outside, the IC. In some cases,
especially on a doubled-sided SMT board, neither path is clear. In that case, the
router will drop the connection and go on to the next one. You can ignore failures
during this sweep, because the router will connect them later. This option is not
recommended. See the note below.

O Note    You should perform fanout on the board prior to autorouting. Fanout is
best performed using the Fanout Settings dialog box. See Fanout on boards with
surface mount devices in Chapter 2 in this manual.

Maze. Sweeps through the design attempting different paths to make connections.

Via Reduce. Use the VIARED_H or VIARED_V strategies to run via reduction on
the fully routed board. In most cases, Via Reduce is unnecessary, since the router
minimizes vias as it progresses through the routing operation.

Auto DFM (Automatically Design for Manufacturer). Attempts to straighten tracks
and clean up the board. You usually do not need to run Auto DFM, because the
router straightens and cleans up the board on its own.

Auto CDE (Automatically Clear Design Errors). Attempts to remove incomplete
tracks from the board so that the design is clean for rerouting.

Options    The Partial option allows tracks to be partially routed during a sweep if
the track extends beyond the active routing window. The Fast option is
recommended for a quick routing or place check; it is not recommended for
production board routing.

Via Cost    Indicates how conservatively or freely the router will use vias to make
connections. In other words, via cost is calculated as the approximate distance that
the router travels in the perpendicular direction (the non-standard direction,
horizontal or vertical, for the layer) before choosing to use a via. The default Via
Costs are 70 for two- and four-layer, through-hole boards, and 40 for almost all
other multilayer and SMT boards.

Retry Cost    Represents the approximate number of times the router tries to shove
tracks aside before it rips up the track or routes through the track. Using values of 30
or 60, the router is not likely to rip up the track, unless the board cannot be easily
routed using shove. If the router rips up a track or routes through a track, it returns to
the track to find a new path for it and completes the connection.
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Route Limit    Controls the amount of effort the router will use to route a given
track. That is, the higher the route limit, the harder the router will try to make a
connection, regardless of how long or winding the track becomes. A Route Limit of
75 or 80 is the recommended value for route limit.

You should always try to route to 100% (or very close) of the connections the first
time through the window, so Route Limit should not be set low, unless you
purposely do not want to route to 100% of the window (for instance, if vias are
prohibited and you really do not expect the router to route 100% of the window).

Attempts    Specifies the number of tries that the router makes on each connection
in the current routing window. Attempts should be set within the range of 2 to 25,
depending on whether you want the router to route 100% of the connections or not.

An Attempts setting of 25 routes to 100% (or very close). A setting of 10 routes 98%
of most boards, a setting of 5 routes 95% of most boards, and a setting of 2 routes
90% of most boards. On the other hand, a low number of attempts routes the board
more quickly.
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Editing route layer parameters

You set general routing criteria, such as layer cost, primary direction, and between
pins cost, by editing the data in the Route Layer spreadsheet.

To edit route layer information

1 Choose the spreadsheet toolbar button, choose Strategy, then choose Route
Layer. The Route Layer spreadsheet displays.

2 Double-click in a cell in the Route Layer spreadsheet. The Edit Layer Strategy
dialog box displays.

3 Set the parameters for Layer Cost, Primary Direction, and Between Pins, then
choose the OK button.

The Edit Layer Strategy dialog box

Layer Cost    Determines how expensive it is to route on a given layer. For
example, for an SMT design, you may want to avoid the outer layers because that is
where the pins are located.

Layer Cost should generally be set within the range of 40 to 60, except for some
special cases. For example, if you want to avoid routing on a particular layer, except
when needed, set the overall cost of that layer to 90.

Generally speaking, for through-hole boards it is best to set each horizontal and
vertical pair of layers to a slightly different overall cost. This distributes the buses
evenly through the board. The default strategies for through-hole boards are already
set up this way.
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Primary Direction    Primary Direction is not set on a scale from 0 to 100. Vertical
layers are assigned a value between 0 and 49, and horizontal layers are assigned a
value between 51 and 100. The closer the value is to 50, the more freedom the router
has to route in any direction on a given layer. The closer the value is to 0, the more
strictly vertical the layer. The closer the value is to 100, the more strictly horizontal
the layer. For most boards, 80 and 20 (for horizontal and vertical layers,
respectively) will suffice.

For the Next sweep, move the values towards 49 (vertical) and 51 (horizontal), in
order to give the router the maximum amount of freedom, while still giving the
router guidance as to which layer goes in which direction.

Between Pins    Gives the router the best possible path selection, and saves the
channels between IC pins for short tracks. That is, the higher the Between Pins
option is set, the less likely tracks are to be routed between pins.
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Editing route spacing parameters

You set general spacing, such as track to track, track to via, track to pad, via to via,
via to pad, and pad to pad, by editing the data in the Route Spacing spreadsheet.

To edit route spacing information

1 Choose the spreadsheet toolbar button, choose Strategy, then choose Route
Spacing. The Route Spacing spreadsheet displays.

2 Double-click in a cell in the Route Spacing spreadsheet. The Edit Spacing
dialog box displays.

3 Set the parameters for Track to Track, Track to Via, Track to Pad, Via to Via,
Via to Pad, and Pad to Pad, then choose the OK button.

The Edit Spacing dialog box

Track to Track Spacing    Track-to-track spacing specifies the minimum space
required between tracks of different nets, and between tracks and obstacles of
different nets. Note that the generic track-to-track spacing set here can be overridden
on a “per-net” basis using the Net Spacing By Layer dialog box, which is accessed
from the Edit Net dialog box, from within the Nets spreadsheet.

Track to Via Spacing    Track-to-via (and obstacle-to-via) spacing specifies the
minimum space required between vias and tracks of different nets.

Track to Pad Spacing    Track-to-pad (and obstacle-to-pad) spacing specifies the
minimum space required between pads and tracks of different nets.

Via to Via Spacing    Via-to-via spacing specifies the minimum space required
between vias of different nets.
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Via to Pad Spacing    Via-to-pad spacing can be used to specify the minimum
space required between pads and vias of the same net (as well as different nets,
which is the usual case). For example, if you wish to keep a distance of 25 mils
between your SMT pads and the fanout vias that are connected to the pads, set Via to
Pad Spacing to 25.

Pad to Pad Spacing    Pad-to-pad spacing specifies the minimum space required
between pads of different nets.
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A
Attempts, 30
auto path route mode, 15

allow off-grid routing, 15
maximize 135 corners, 15
shove components, 15

Autoroute command, 16
autorouting, 16

connecting nets to plane layers
for boards with through-holes, 6
SMT boards, 8

gridded, 1
gridless, 1, 2
layer parameters, 31
passes, 28
pre-routing critical nets, 15
single-sided boards, 19
spacing parameters, 33
sweeps, 16, 25

B
Between Pins, 32
Board command, 8, 9, 12, 16

C
commands

Autoroute, 16
Board, 8, 9, 12, 16
Component, 8
Convert to Components, 20, 21, 22
Copy, 19
Create Reports, 18
Design Rule Check, 9, 17
DRC/Route Box, 8
Enable<->Disable, 16

Fanout, 8, 9, 12
Fanout Settings, 9, 12
Jumper, 20, 21, 22
Jumper Settings, 20, 21
Load, 5, 20
Lock, 15, 21
Properties, 17, 19
Route Settings, 13, 15
Test Point Settings, 17

Component command, 8
connecting nets to plane layers, 6
Convert to Components command, 20, 21, 22
Copy command, 19
Create Reports command, 18
creating jumpers for single-sided boards, 22
critical nets, pre-routing, 15

D
Design Rule Check command, 9, 17
disabling nets for routing, 16
DRC/Route Box command, 8
DRC/Route Box, resizing, 27

E
editing

route layer information, 31
route pass information, 28
route spacing information, 33
route sweep information, 25

Enable<->Disable command, 16

Index
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F
fanout, 12

full board, 12
power and ground, 9

Fanout command, 8, 9, 12
Fanout Settings command, 9, 12

G–H
gridded autorouting, 1

interactive routing tools, 2
shove technology, 1
sweep technology, 1

gridless autorouting, 1, 2
SmartRoute, 2

ground
connecting to plane layer, 6
fanout, 9
verifying connection to plane layer, 7

I
interactive routing, 13
interactive routing tools

auto path route, 2
defined, 2
shove track, 2

J–K
Jumper command, 20, 21, 22
jumper layer, 19
Jumper Settings command, 20, 21
jumpers, 19
jumpers, creating for single-sided boards, 22

L–M
Layer Cost, 31
layers, parameters for autorouting, 31
library manager, 19
Load command, 5, 20
loading, routing strategy file, 5
Lock command, 15, 21

N–O
nets

connecting to plane layers, 6
disabling, 16
pre-routing critical, 15
verifying connection to plane layer, 7

P–Q
passes, in autorouting, 28
plane layers

connecting nets, 6
verifying connection of nets, 7

power
connecting to plane layer, 6
fanout, 9
verifying connection to plane layer, 7

pre-routing critical nets, 15
Primary Direction, 32
Properties command, 17, 19

R
resizing, DRC/Route Box, 27
Retry Cost, 29
Route Layer spreadsheet, 24
Route Limit, 30
Route Pass spreadsheet, 24
Route Settings command, 13, 15
Route Spacing spreadsheet, 24
Route Sweep spreadsheet, 24
routing

auto path route, 13
interactive, 13
shove track, 13
shoving tracks interactively, 13, 14

routing modes
auto path route mode, 15
interactive, 2
shove track mode, 13
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S
shove technology, defined, 1
shove track mode, 13

high power, 13
low power, 13
medium power, 13

shoving tracks interactively, 13, 14
single-sided boards, 19
SMT boards

performing fanout, 8
preparing for routing, 8

spacing, parameters for autorouting, 33
spreadsheets

Route Layer, 24
Route Pass, 24
Route Spacing, 24
Route Sweep, 24

strategy files, loading, 5
sweep technology, defined, 1
sweeps

autorouting, 16
editing, 25
Maze Route, 25
Next, 25
Preliminary Route, 25
Special Options, 25
Win/Comp, 25

T–U
technology templates, 19
Test Point Settings command, 17
test points, generating automatically, 17
thermal reliefs, 6
through-holes

connecting nets to plane layers, 6
preparing boards for routing, 6

V–Z
Via Cost, 29
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